Finance INB Navigation

Table of Contents
A Start-up List of Finance INB Forms .......................................................... 1
Log-on and log-off for Banner........................................................................ 2
Starting with GUAGMNU and Form Names...................................................... 3
Navigating INB Forms: Explore on Your Own!............................................... 4
Querying Information – Wildcard Search Aids................................................. 4
Encumbrance Inquiry Forms ......................................................................... 5
Procurement Inquiry Forms ............................................................................ 5
Transaction Inquiry Forms .............................................................................. 6
Document Inquiry Forms ................................................................................ 6
Grant Inquiry Forms ......................................................................................... 7
Budget Inquiry Forms ...................................................................................... 7
General Ledger Inquiry Forms ....................................................................... 8
Endowment Form .............................................................................................. 8
Chart of Accounts (Maintenance) Forms........................................................ 8
Hierarchy Inquiry Forms ................................................................................. 8
INB Navigation and Forms Exercises, Using FY09: ....................................... 9
Answer Key ....................................................................................................... 10
Keyboard Shortcuts .......................................................................................... 19
Form Names – What Do They Mean? .............................................................. 20

A Start-up List of Finance INB Forms

Encumbrance Inquiry Forms
FGIOENC Organizational Encumbrance List (Open)
FGIENC Encumbrance List
FGIENCD Detail Encumbrance Activity Form

Procurement Inquiry Forms
FPIPURR Purchase Order Inquiry Form
FOIDOCH Document History (Procurement Process)
FPPOPOV Open Purchase Orders by Vendor Form
FPPOPOH Purchase Order Validation Form
FPPOPOF Open Purchase Orders by FOAPAL
FAINV Invoicing/Credit Memo Query
FAIOINF Open Invoicing by FOAPAL
FAIVNDH Vendor Detail History Form
FAIVHIS Vendor History Query Form
FAIVINV Vendor Invoice History Form

Transaction Inquiry Forms
FGITRND Operating Accounts Transaction Detail

Document Inquiry Forms
FGIDOCR Document Retrieval Inquiry
FGIJVCD List of Suspended Journal Vouchers

Grant Inquiry Forms
FRIGITD Grant Inception to Date
FRAGRTN Grant Maintenance

Budget Inquiry Forms
FGIBDOR Executive Summary Form
FGIBDST Organizational Budget Status Form
FGIBAVL Budget Availability Status Form
FGIBSUM Organizational Budget Summary Form

General Ledger Inquiry Forms
FGITBAL General Ledger Trial Balance
FGITBRS Trial Balance Summary Form
FGIgLAC General Ledger Transaction Detail

Endowment Form
FNMENDW Endowment Fund Definition

Chart of Accounts (Maintenance) Forms
FTMFUND Fund Manager, Effective Dates
FTMORGN Orgn Manager, Effective Dates
FTMACCT Account Code Maintenance
FTMCPROG Program Code Maintenance

Hierarchy Inquiry Forms
FTIFNDH Fund Hierarchy Query
FTIORGH Organization Hierarchy Query
FTIACTH Account Hierarchy Query
FTIPRCH Program Hierarchy Query
FTILCH Location Hierarchy Query
Log-on and log-off for Banner

A. **Logon to Banner**
   1. You will use your Banner Oracle ID (license plate) and password.
   2. Access to Banner INB Production is available in Raiderlink’s Top Menu:
      
      ![Banner INB Navigation](image)
      
      a. An empty/blank window, ‘Oracle Fusion Middleware Forms Services” is opened and may appear in the task bar at the bottom of your monitor.
      
      b. If RaiderLink is unavailable, or if multiple Banner windows are desired, an alternate link is available on the AFISM website:

      **RaiderLink > A&F Work Tools > AFISM**
      **‘Home’ > ERP Tools > TTUSPRD**
      - or -  **www.depts.ttu.edu/afism/**

      **Use this link to open multiple windows!**

   3. At the **Logon** window enter your Banner “**Oracle ID** “and password. Leave **Database** empty, and press **ENTER** or click **CONNECT**.

   ![Logon window](image)

   4. An additional window, ‘Oracle Fusion Middleware Forms Services” is opened with Banner General Menu GUAGMNU, seen in the blue band immediately above a Welcome greeting to you (illustration on next page). The Banner window is represented by this icon on the task bar at the bottom of your monitor.
B. **Logout (from the general menu, GUAGMNU)**

   CAUTION: If the empty/blank window opened in step 2.a is exited, it will automatically close the Banner window and all forms that are open!!

1. Be sure all Banner forms are closed. Click the Form exit (black X on the icon bar) to close any forms that are open.
2. To exit Banner,
   a. Either click the Form exit (black X on the icon bar), or click the window exit.
   b. Reminder Window: Are you sure you want to exit this Banner session? Click YES.
   c. Close the additional window, “Oracle Fusion Middleware Forms Services”

C. **Your Banner (Oracle) ID and Password**

1. From Raiderlink, access TeamApp under A&F Work Tools tab/AFISIM, OR directly access at: [http://team.texastech.edu](http://team.texastech.edu) with your eRaider ID and password)
2. Your Oracle ID will be displayed.
3. Enter a new Password and click on “set password” to change your password.

**Starting with GUAGMNU and Form Names**

The General Menu, GUAGMNU, is the front door of Banner.
Navigating INB Forms: Explore on Your Own!

**MENU BAR:**

| File | Edit | Options | Block | Item | Record | Query | Tools | Window | Help |

**ICON BAR:**

**BLOCK:**
How many icons perform block functions? _________________________
Is the background image ___ a page ___ blocks ___ a round stack?

**RECORD:**
How many icons perform record functions? _________________________
Is the background image ___ a page ___ blocks ___ a round stack?

**QUERY:**
How many icons perform query functions? _________________________
Is the background image ___ a page ___ blocks ___ a round stack?

**OTHER:**
What other icons do you see that you already know? ________________
_________________________________________________________________

**MENU BAR:**
How many choices are available on the:
- Block Menu ____ Item Menu ____ Record Menu ____ Query Menu ____
What choices do you recognize on the File menu? ____________________
Why is the First Letter of the menu descriptors is underlined?
_________________________________________________________________

*For Keyboard Shortcuts, see page 19.*

**Querying Information – Wildcard Search Aids**

Querying allows you to search for information stored in Banner. Some forms automatically open in query mode (will show in the help line); others will have to be put in query mode to run queries.

**SEARCH WILDCARDS:**

| % | Any combination before or after your entry. |
| _ | Any character in this column. |

**Examples:**

<table>
<thead>
<tr>
<th>Enter:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>%ma%</td>
<td>Entries that contain “ma”</td>
</tr>
<tr>
<td>ma%</td>
<td>Entries that begin with “ma”</td>
</tr>
<tr>
<td>%ma</td>
<td>Entries that have “ma” as the last two characters</td>
</tr>
<tr>
<td>m_m</td>
<td>Entries that have “m” as the first and third character</td>
</tr>
<tr>
<td>_m%</td>
<td>Entries that have “m” as the second character</td>
</tr>
</tbody>
</table>
Encumbrance Inquiry Forms

FGIOENC  Organizational Encumbrance List
Can enter by Fund only, Org only or both
Provides list of open encumbrances by
Org or Fund or both
Use Options to open
• Query Detail Encumbrance Info
  [FGIENCD]

FGIENCD  Detail Encumbrance Activity
Requires Document Number
Provides detailed transaction activity for an original
encumbrance and transaction activity against
that encumbrance (Description, Balance, Vendor,
FOAPAL, Encumbrance Amount, Liquidation
Amount, Invoice Information) Does not provide
Receiver and Check information
This is a query only form

FGIENCB  Encumbrance List
Query any encumbered document
Provides Description, Current Balance, Status (open,
closed, etc.), dates
This is a query only form

Procurement Inquiry Forms

FPIPURR  Purchase Order Inquiry Form
Requires Purchase Order or Blanket Order Number
This is a query only form

FOIDOCH  Document History
Requires Purchase Order or Invoice or Check or Asset
Use Options to open Purchase Order [FPIPURR], Invoice [FAIINVE], Check Payment History
  [FAICHKH], Asset Tags/Adjustments

FPIOPOV  Open Purchase Orders by Vendor Form
Requires Vendor, Status (Open, Closed, Cancelled, Incomplete, All)
Provides PO Number, Description, Date, Quantity, UOM and Amount

FPIPOHD  Purchase Order Validation Form
Query by PO or Blanket Number, PO Date, Delivery Date, Vendor
Use Options to open
• Commodities for Review Query [FOICOMM]
  o Commodities and Accounting [FOICACT]
• Purchase/Blanket/Change Order [FPIPURR]
FPIOPOF  Open Purchase Orders by FOAPAL
Search by any of the following: Chart, Fund, Organization, Account, and Program
Use Options to open Purchase Order [FPIPURR], Commodities [FOICOMM]

FAIINV  Invoice/Credit Memo Query
Requires Invoice Number
Provides invoice detail

FAIOINF  Open Invoice by FOAPAL
Search by Chart, Fund, Organization, Account and/or Program
Provides Invoice, Vendor, Description and Amount

FAIVNDF  Vendor Detail History Form
Requires Vendor
Provides Vendor Invoice, AP Invoice Doc ID, Invoice Amount, Check Date, Check Number
Use Options to open Invoice [FAAINVE], Commodity Information [FOICOMM], and Vendor Invoice [FAIVINV]

FAIVHIS  Vendor History Query Form
Requires Vendor
Search by All, Cancelled, Not Cancelled
Use Options to open: Credit Memos, Open Invoices, and Paid Invoices

FAIVINV  Vendor Invoice History Form
Requires Vendor, Document Number
Provides Vendor invoice, date, total, status, and items

Transaction Inquiry Forms

FGITRND  Detail Transaction Activity
Can query by any FOAPAL combination plus first row of the next block  (Account, Organization, Program, Document, Description, Fund, Amount, Fund Balance) and each of these columns is searchable
Use Options to open
• Query Transaction Source Info (by type) [FGIDOCR]
• Detail Encumbrance Info [FGIENCD] (For encumbrance docs only)

Only on this form, FGITRND: Use the Help Menu > Extract Data No Key to transfer results to Excel for further analysis.

Document Inquiry Forms

FGIDOCR  Document Retrieval Inquiry
Requires Document Number
Provides document detail information including FOAPAL
Use Options to open
• Document Posting Information [FGQDOCP]

FGIJVCD  List of Suspended Journal Vouchers
Provides Document, Description, Amount, Transaction Date, Status
This is a query only form
Grant Inquiry Forms

FRIGITD  Grant Inception to Date
Requires COA and Grant; Can search by Account Type and any combination of FOAPAL
Shows Account Type, Adjusted Budget, Activity, Commitments and Available Balance
Use Options to open
  • Grant Transaction Detail Form [FRIGTRD]
  o Query Document by Type
  o Encumbrance Detail [FGIENCD]
  o Query Total for all Records

FRAGRNT  Grant Maintenance
Shows Grant, Principal Investigator, Agency, Amount, Status,
Project Dates, Sponsor ID, Responsible Organization
This is a query only form.

Budget Inquiry Forms

FGIBDSR  Executive Summary for Budget
Can enter by Fund only, Org only or both
Provides Adjusted Budget, YTD Activity, Commitments and Available Balance by Account
  Allows for queries at higher level chart components within the chart hierarchy
Use Options to open
  • Transaction Detail Information [FGITRND]
    o Query Document (by type)
    o Detail Encumbrance Activity [FGIENCD]

FGIBDST  Organization Budget Status
Can enter by Fund only, Org only or both
Provides Adjusted Budget, YTD Activity, Commitments and Available Balance by Account
  Will not return values for queries at higher level chart components within the chart hierarchy
Use Options to open
  • Budget Summary Information [FGIBSUM]
  o Organization Budget Status [FGIBDST]
  • Organization Encumbrance List [FGIOENC]
    o Detail Encumbrance Activity [FGIENCD]
  • Transaction Detail Information [FGITRND]

FGIBAVL  Budget Availability Status
Requires Fund, Org, Account
Shows budget availability for a FOAP as of the current system date, including suspended, unapproved and unposted documents
Provides Adjusted Budget, YTD Activity, Commitments and Available Balance
This is a query only form.
FGIBSUM  Organization Budget Summary
Can enter by Fund only, Org only or both
Provides Adjusted Budget, YTD Activity, Commitments and Available Balance by Account Type (ie Revenue, Direct Expenditures, etc.)
Use Options to open
  • Budget Status Information [FGIBDST]
    o Organization Encumbrances [FGIOENC]
    o Transaction Detail Information [FGITRND]

General Ledger Inquiry Forms

FGITBAL  General Ledger Trial Balance
Requires Fund; can also enter Account Type and/or Account
Provides Account, Description and Balances
Use Options to open
  • Query General Ledger Activity [FGIGLAC]
    o Query Transaction Source Info (by type) [FGIDOCR]

FGITBSR  Trial Balance Summary
Requires Fund or Fund Type; can also enter Account and/or Account Type
Provides Account Type, Description, Balances
Use Options to open
  • Query General Ledger Activity [FGIGLAC]
    o Query Transaction Source Info (by type) [FGIDOCR]

FGIGLAC  General Ledger Activity
Requires Fund; Can also enter Account
Provides GL account, document ID, description, Amount,
Use Options to open
  • Query Transaction Source Info (by type)

Endowment Form

FNMENDW  Endowment Fund Definition
Provides Endowment Fund Definitions

Chart of Accounts (Maintenance) Forms

FTMFUND  Fund Manager, Effective Date
FTMORGN  Orgn Manager, Effective Date
FTMACCT  Account Codes
FTMPROG  Program Codes

Hierarchy Inquiry Forms

FTIFNDH  Fund Hierarchy Query
FTIORGH  Organization Hierarchy Query
FTIACTH  Account Hierarchy Query
FTIPRGH  Program Hierarchy Query
FTILOCH  Location Hierarchy Query
INB Navigation and Forms Exercises, Using FY09:

1. Look up the budget (FGIBDST) for:
   a. 11A007 B53000 400
   b. Open 7C0181 (FGITRND)
   c. Open Detail Encumbrance Info

2. Look up Clearing Account 18A090 for FY09 (FGITBAL)
   a. Open 2A0073 activity
   b. Look up FY10 activity

3. Look up transaction detail activity (FGITRND)
   a. 11A007 B53000 400
   b. Enter a query to look up 7C0 account codes only
   c. Open one of the documents listed

4. Look up PO information
   a. P0027649 (FGIENCD)
      i. How many records are there?
      ii. Is the PO open?
      iii. Search Encumbrance List
          1. Enter Query
          2. Search for %PURC85% in description
          3. Search for only open documents that start with PU

5. Look up PO Document History
   a. P0000745 (FOIDOCH)
      i. Open PO
      ii. Open invoice
      iii. Open check (bank code 31)
          1. Look up vendor invoice number
      iv. Open asset tag

6. Look up open PO by FOAP (FPIOPOF)
   a. 11A007 B53000 400
      i. View Commodities
      ii. View Purchase Order

7. Look up Vendor Detail History (FAIVNDH)
   a. Search for Goodwin Powell Office Supplies
   b. How many invoices have been paid for FY10?
   c. What is the vendor invoice number?
   d. View Commodity
   e. View Invoice

8. Who is the Orgn Manager for B51004 (FTMORGN)
   a. Who was the previous Orgn manager and when was it changed?

9. Who is the Fund Manager for 17A019 (FTMFUND)
   a. Who was the previous fund manager?

10. Look up document (FGIDOCR)
    a. Look up budget BD0J9664
1. **Look up the budget (FGIBDST) for:**
   a. 11A007 B53000 400
   b. Open 7C0181 (FGITRND)
   c. Open Detail Encumbrance Info

**Answer:** Enter FGIBDST from main menu in Go To section; Enter

1.a. Enter Chart, FY, Organization, Fund and Program – Next Block
   Note – Uncheck Include Revenue Accounts* see info below

1.b. Next Record (arrow down) to account code 7C0181

1.c. Click on Options; Detail Encumbrance Info FGIENC
Note: Use the black X from the icon menu to close out forms and get back to main page.

*Include Revenue Accounts Checkbox

<table>
<thead>
<tr>
<th>Chart:</th>
<th>Organization:</th>
</tr>
</thead>
<tbody>
<tr>
<td>T ▼</td>
<td>BU5000 ▼</td>
</tr>
<tr>
<td>Fiscal Year:</td>
<td>Fund:</td>
</tr>
<tr>
<td>10 ▼</td>
<td>11A007 ▼</td>
</tr>
<tr>
<td>Index:</td>
<td>Program:</td>
</tr>
<tr>
<td>▼</td>
<td>400 ▼</td>
</tr>
<tr>
<td>▼</td>
<td>Account:</td>
</tr>
<tr>
<td>▼</td>
<td>Account Type:</td>
</tr>
<tr>
<td>▼</td>
<td>▼</td>
</tr>
<tr>
<td>▼</td>
<td>Activity:</td>
</tr>
<tr>
<td>▼</td>
<td>▼</td>
</tr>
<tr>
<td>▼</td>
<td>Location:</td>
</tr>
<tr>
<td>▼</td>
<td>▼</td>
</tr>
<tr>
<td>▼</td>
<td>▼</td>
</tr>
<tr>
<td>▼</td>
<td>▼</td>
</tr>
<tr>
<td>▼</td>
<td>▼</td>
</tr>
</tbody>
</table>

Results leaving checked:

<table>
<thead>
<tr>
<th>7C0209</th>
<th>E</th>
<th>MS Consumables Office</th>
<th>826.00</th>
<th>-23.75</th>
<th>826.00</th>
<th>23.75</th>
</tr>
</thead>
<tbody>
<tr>
<td>7C0210</td>
<td>E</td>
<td>MS Furnish/Equip Noncapa</td>
<td>11,915.70</td>
<td>19,658.93</td>
<td>1,162.00</td>
<td>94.90</td>
</tr>
<tr>
<td>7C0208</td>
<td>E</td>
<td>MS Parts Computer Equip N</td>
<td>476.40</td>
<td>167.90</td>
<td>368.50</td>
<td>0.90</td>
</tr>
<tr>
<td>7C0200</td>
<td>E</td>
<td>MS Computer Equip Cntle</td>
<td>9,204.83</td>
<td>9,204.83</td>
<td>0.00</td>
<td>0.90</td>
</tr>
<tr>
<td>Net Total:</td>
<td>1,076,633.91</td>
<td>151,227.06</td>
<td>868,671.09</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Results unchecked:

<table>
<thead>
<tr>
<th>7C0209</th>
<th>E</th>
<th>MS Consumables Office</th>
<th>826.00</th>
<th>-23.75</th>
<th>826.00</th>
<th>23.75</th>
</tr>
</thead>
<tbody>
<tr>
<td>7C0210</td>
<td>E</td>
<td>MS Furnish/Equip Noncapa</td>
<td>11,915.70</td>
<td>19,658.93</td>
<td>1,162.00</td>
<td>94.90</td>
</tr>
<tr>
<td>7C0208</td>
<td>E</td>
<td>MS Parts Computer Equip N</td>
<td>476.40</td>
<td>167.90</td>
<td>368.50</td>
<td>0.90</td>
</tr>
<tr>
<td>7C0200</td>
<td>E</td>
<td>MS Computer Equip Cntle</td>
<td>9,204.83</td>
<td>9,204.83</td>
<td>0.00</td>
<td>0.90</td>
</tr>
<tr>
<td>Net Total:</td>
<td>1,076,633.91</td>
<td>151,227.06</td>
<td>868,671.09</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. **Look up Clearing Account 18A090 for FY09 (FGITBAL)**
   a. Open 2A0073 activity
   b. Look up FY10 activity

**Answer:**
Enter FGITBAL from main menu in Go To section; Enter

2a. **Enter Chart, FY and Fund - Next Block**

![General Ledger Trial Balance FGITBAL 7.4.0.1 (UDEV) (TTU)](chart)

<table>
<thead>
<tr>
<th>Chart:</th>
<th>Fund: 16A090</th>
</tr>
</thead>
<tbody>
<tr>
<td>T ▼</td>
<td>Ranching Heritage Revenue Clearing</td>
</tr>
<tr>
<td>Fiscal Year:</td>
<td>Account: ▼</td>
</tr>
<tr>
<td>09 ▼</td>
<td>▼</td>
</tr>
</tbody>
</table>
Arrow down and highlight 2A0073 and click on Options from menu bar

From Options Select Query General Ledger Activity Info (FGIGLAC)

2.b. Close FGIGLAC with black X from icon bar and use the rollback icon to return to the header of FGITBAL. Change FY to 10 and Next Block.
3. **Look up transaction detail activity (FGITRND)**
   a. 11A007 B53000 400
   b. Enter a query to look up 7C0 account codes only
   c. Open one of the documents listed

   **Answer:** Enter FGITRND from main menu in Go To section; Enter 3.a Enter Chart, FY, FOP - Next Block

   ![Use % as wildcards for queries]

   ![Click on Options to "drill down" to other documents]

3.b. Form begins in query mode. Enter 7C0% in Account Field and Execute Query (F8).

3.c. Use Arrow keys or scroll bar to highlight a transaction line; click on Options; Query Document by type

4. **Look up PO information**
   a. P0027649 (FGIENCD)
      i. How many records are there?
      ii. Is the PO open?
      iii. Search Encumbrance List
         1. Enter Query
         2. Search for %PURC85% in description
         3. Search for only open documents that start with PU

   **Answer:** Enter FGIENCD from main menu in Go To section; Enter 4.a. Enter P0027649 in Encumbrance field of FGIENCD – Next Block
4.a.i. Use Next Record icon or arrow down key to view records for this PO.

4.a.ii. Status indicates Open or Closed Encumbrance (not if line item or record is closed)
4.a.iii Search Encumbrance List from Header by clicking on search icon next to encumbrance field

Enter Query (F7), type in query criteria and execute query (F8)

**Encumbrance**:

<table>
<thead>
<tr>
<th>Encumbrance Number</th>
<th>Type</th>
<th>Description</th>
<th>Current Balance</th>
<th>FY</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>PU%</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**NOTE:** double click on the encumbrance number or highlight and use the select icon to view encumbrance information.

5. **Look up PO Document History**
   a. P0000745 (FOIDOCH)
      i. Open PO
      ii. Open invoice
      iii. Open check (bank code 31)
        1. Look up vendor invoice number
      iv. Open asset tag

**Answer:** Enter FOIDOCH from main menu in Go To section; Enter 5.a Enter Document Type (PO) and Document Code P0000745 – Next Block

6. **Look up open PO by FOAP (FPIOPOF)**
   a. 11A007 BS3000 400
      i. View Commodities

**NOTE:** When drilling down to check number, use 31 in Bank Code in the Check Payment History form.
ii. View Purchase Order

**Answer:** Enter FPIOPOF from main menu in Go To section; Enter

6.a. Enter Chart and FOP – Next Block

Using arrow keys, select purchase order you wish to view. Use Options to View Commodities or Purchase Order

---

7. Look up Vendor Detail History (FAIVNDH)

a. Search for Goodwin Powell Office Supplies
b. How many invoices have been paid for FY10?
c. What is the vendor invoice number?
d. View Commodity
e. View Invoice

**Answer:** Enter FPIOPOF from main menu in Go To section; Enter

7.a. Use the search icon to find the R# for Goodwin Powell Office Supplies

Select the FTIIDEN link. Form begins in query mode, enter criteria and execute query (F8).

Find the vendor from the search results and double click or use the select icon. Use the tab key to populate Vendor name from R#. Next Block
8. **Who is the Orgn Manager for B51004 (FTMORGN)?**

   a. Who was the previous Orgn manager and when was it changed?

   **Answer:** Enter FTMORGN from main menu in Go To section; Enter

   8.a. Enter a Query and then use the search icon to search for a specific organization or type in chart and organization. Execute Query.

   Tab cursor to Financial Manager field and next record (arrow down) to see previous financial manager(s). Look at Effective Date.

   ![Chart of Accounts](chart_of_accounts.png)

   - **Organization:** B51004
   - **Effective Date:** 05-SEP-2008
   - **Financial Manager:** R00910657 - Thompson, Leslie D.
9. **Who is the Fund Manager for 17A019 (FTMFUND)**
   a. Who was the previous fund manager?

   **Answer:** Enter FTMFUND from main menu in Go To section; Enter 9.a. Enter a Query and then use the search icon to search for a specific fund or type in chart and fund. Execute Query.

   Tab cursor to Financial Manager field and next record (arrow down) to see previous financial manager(s). Look at Effective Date.

10. **Look up document (FGIDOCR)**
   a. Look up budget BD0J9664

   **Answer:** Enter FGIDOCR from main menu in Go To section and Enter. Enter document number and Next Block
## Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Function Group</th>
<th>Key(s)</th>
<th>ALT-Menu, &amp; Icons</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Basic Functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show Keys</td>
<td>CTRL + F1</td>
<td>N/A</td>
</tr>
<tr>
<td>Save Changes</td>
<td>F10</td>
<td>File/Save</td>
</tr>
<tr>
<td>Print</td>
<td>Shift + F8</td>
<td>File/Print</td>
</tr>
<tr>
<td>Clear Form and Rollback</td>
<td>Shift + F7</td>
<td>File/Rollback</td>
</tr>
<tr>
<td>Exit Form</td>
<td>CTRL + Q</td>
<td>File/Exit</td>
</tr>
<tr>
<td><strong>Block Functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Next Block</td>
<td>CTRL + Page Down</td>
<td>Block/Next</td>
</tr>
<tr>
<td>Previous Block</td>
<td>CTRL + Page Up</td>
<td>Block/Previous</td>
</tr>
<tr>
<td>Clear Block</td>
<td>Shift + F5</td>
<td>Block/Clear</td>
</tr>
<tr>
<td><strong>Record Functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Next Record</td>
<td>Down Arrow</td>
<td>Record/Next</td>
</tr>
<tr>
<td>Previous Record</td>
<td>Up Arrow</td>
<td>Record/Previous</td>
</tr>
<tr>
<td>Clear Record</td>
<td>Shift + F4</td>
<td>Record/Clear</td>
</tr>
<tr>
<td>Insert Record</td>
<td>F6</td>
<td>Record/Insert</td>
</tr>
<tr>
<td>Duplicate Record</td>
<td>F4</td>
<td>Record/Duplicate</td>
</tr>
<tr>
<td>Remove Record</td>
<td>Shift + F6</td>
<td>Record/Remove</td>
</tr>
<tr>
<td><strong>Item/Field Functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Next Field</td>
<td>Tab</td>
<td>Item/Next</td>
</tr>
<tr>
<td>Previous Field</td>
<td>Shift + Tab</td>
<td>Item/Previous</td>
</tr>
<tr>
<td>List of Values/Flashlight</td>
<td>F9</td>
<td>Help/List</td>
</tr>
<tr>
<td>Next Primary Key.........?</td>
<td>Shift + F3</td>
<td>N/A</td>
</tr>
<tr>
<td>Clear Field</td>
<td>CTRL + U</td>
<td>Item/Clear</td>
</tr>
<tr>
<td>Duplicate Field</td>
<td>F3</td>
<td>Item/Duplicate</td>
</tr>
<tr>
<td>Next Radio Button Item</td>
<td>Right Arrow</td>
<td>N/A</td>
</tr>
<tr>
<td>Prev Radio Button Item</td>
<td>Left Arrow</td>
<td>N/A</td>
</tr>
<tr>
<td>Ck/Unck Check Box Field</td>
<td>Space Bar</td>
<td></td>
</tr>
<tr>
<td><strong>Query Functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enter Query</td>
<td>F7</td>
<td>Query/Enter</td>
</tr>
<tr>
<td>Execute Query</td>
<td>F8</td>
<td>Query/Execute</td>
</tr>
<tr>
<td>Exit Query with Value</td>
<td>Shift + F3</td>
<td>N/A (Click OK?)</td>
</tr>
<tr>
<td>Count Query Hits</td>
<td>Shift + F2</td>
<td>Query/Count Hits</td>
</tr>
</tbody>
</table>
### Form Names – What Do They Mean?

Position 1: Identifies the System which owns the Form, Report, Job, or Table
Position 2: Identifies the Application Module which owns the Form, Report, Job, or Table
Position 3: Identifies the Type of Form, Report, Job, or Table
Position 4-7: A Short Description (name) the Form, Report, Job, or Table

#### Position 1: Identifies the System owning the Form, Report, Job, or Table

<table>
<thead>
<tr>
<th>Position</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Alumni/Development</td>
</tr>
<tr>
<td>B</td>
<td>Property Tax</td>
</tr>
<tr>
<td>C</td>
<td>Courts</td>
</tr>
<tr>
<td>D</td>
<td>Cash Drawer</td>
</tr>
<tr>
<td>E</td>
<td>Finance</td>
</tr>
<tr>
<td>F</td>
<td>General</td>
</tr>
<tr>
<td>G</td>
<td>Information Access</td>
</tr>
<tr>
<td>H</td>
<td>Work Management</td>
</tr>
</tbody>
</table>
| I        | A
| J        | B
| K        | C
| L        | D
| M        | E
| N        | F
| O        | G
| P        | H
| Q        | I
| R        | J
| S        | K
| T        | L
| U        | M
| V        | N
| W        | O
| X        | P
| Y        | Q
| Z        | R

#### Position 2: Identifies the Module owning the Form, Report, Job, or Table

<table>
<thead>
<tr>
<th>General (G)</th>
<th>Student (S)</th>
<th>Finance (F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>E Event Management</td>
<td>A Admissions</td>
<td>A Accounts Payable</td>
</tr>
<tr>
<td>J Job Submissions</td>
<td>C Catalog</td>
<td>B Budget Development</td>
</tr>
<tr>
<td>L Letter Generation</td>
<td>E Support Services</td>
<td>C Cost Accounting</td>
</tr>
<tr>
<td>O Overall</td>
<td>F Registration/Fee Assmt</td>
<td>E Electronic Data Interchange</td>
</tr>
<tr>
<td>P Purge</td>
<td>G General Student</td>
<td>F Fixed Assets</td>
</tr>
<tr>
<td>S Security</td>
<td>H Grades/Acad History</td>
<td>G General Ledger</td>
</tr>
<tr>
<td>T Validation Form/Table</td>
<td>I Faculty Load</td>
<td>I Investment Management</td>
</tr>
<tr>
<td>U Utility</td>
<td>K Reserved for SCT Int.</td>
<td>O Operations</td>
</tr>
<tr>
<td>X Cross Product</td>
<td>L Location Management</td>
<td>P Purchasing/Procurement</td>
</tr>
<tr>
<td>Accounts Receivable (T)</td>
<td>M CAPP</td>
<td>R Research Accounting</td>
</tr>
<tr>
<td>Finance Accounts Rec</td>
<td>O Overall</td>
<td>S Stores Inventory</td>
</tr>
<tr>
<td>General Accounts Rec</td>
<td>P Person</td>
<td>T Validation Form/Table</td>
</tr>
<tr>
<td>Overall</td>
<td>R Recruiting</td>
<td>U Utility</td>
</tr>
<tr>
<td>Student Accounts Rec</td>
<td>S Scheduling</td>
<td>X Archive/Purge</td>
</tr>
<tr>
<td>Validation Form/Table</td>
<td>T Validation Table/Form</td>
<td></td>
</tr>
<tr>
<td>Utility</td>
<td>U Utility</td>
<td></td>
</tr>
</tbody>
</table>

#### Financial Aid (R)

<table>
<thead>
<tr>
<th>HR/Payroll (P) or Position (N)</th>
<th>Information Access (I)</th>
</tr>
</thead>
<tbody>
<tr>
<td>B Budgeting</td>
<td>A Application</td>
</tr>
<tr>
<td>C Record Creation</td>
<td>B Budget</td>
</tr>
<tr>
<td>E Electronic Data Exchange</td>
<td>C COBRA</td>
</tr>
<tr>
<td>F Funds Management</td>
<td>D Benefit/Deductions</td>
</tr>
<tr>
<td>H History &amp; Transcripts</td>
<td>E Employee</td>
</tr>
<tr>
<td>J Student Employment</td>
<td>H Time Reporting/History</td>
</tr>
<tr>
<td>L Logging</td>
<td>O Overall</td>
</tr>
<tr>
<td>N Need Analysis</td>
<td>P General Person</td>
</tr>
<tr>
<td>O Common Functions</td>
<td>R Electronic Approvals</td>
</tr>
<tr>
<td>P Packaging &amp; Disbursements</td>
<td>S Security</td>
</tr>
<tr>
<td>R Requirements Tracking</td>
<td>T Validation Table/Form</td>
</tr>
<tr>
<td>S Student Sys Shared Data</td>
<td>U Utility</td>
</tr>
<tr>
<td>T Validation Form/Table</td>
<td>T Tax Administration</td>
</tr>
<tr>
<td>Utility</td>
<td>T Utility</td>
</tr>
</tbody>
</table>
### Position 3: Identifies the Type of Form, Report, Job, or Table

<table>
<thead>
<tr>
<th>General (G)</th>
<th>Student (S)</th>
<th>Finance (F)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Application Form</td>
<td>A</td>
</tr>
<tr>
<td>B</td>
<td>Base Table</td>
<td>B</td>
</tr>
<tr>
<td>I</td>
<td>Inquiry Form</td>
<td>I</td>
</tr>
<tr>
<td>O</td>
<td>Online COBOL Process</td>
<td>P</td>
</tr>
<tr>
<td>Q</td>
<td>Query Form</td>
<td>Q</td>
</tr>
<tr>
<td>R</td>
<td>Rule Table</td>
<td>R</td>
</tr>
<tr>
<td></td>
<td>Repeating Table</td>
<td>Repeating Table</td>
</tr>
<tr>
<td></td>
<td>Reports/Process</td>
<td>Reports/Process</td>
</tr>
<tr>
<td>V</td>
<td>Validation Form/Table View</td>
<td>V</td>
</tr>
<tr>
<td>T</td>
<td>General Maintenance</td>
<td></td>
</tr>
</tbody>
</table>

#### Financial Aid (R)

<table>
<thead>
<tr>
<th>Position Control (N)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
</tr>
<tr>
<td>B</td>
</tr>
<tr>
<td>I</td>
</tr>
<tr>
<td>P</td>
</tr>
<tr>
<td>R</td>
</tr>
<tr>
<td>T</td>
</tr>
<tr>
<td>V</td>
</tr>
</tbody>
</table>

#### HR/Payroll/Personnel (P)

<table>
<thead>
<tr>
<th>Accounts Receivable (T)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
</tr>
<tr>
<td>P</td>
</tr>
<tr>
<td>I</td>
</tr>
<tr>
<td>P</td>
</tr>
<tr>
<td>R</td>
</tr>
<tr>
<td>T</td>
</tr>
<tr>
<td>V</td>
</tr>
</tbody>
</table>

#### Information Access (I)

<table>
<thead>
<tr>
<th>Report</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
</tr>
</tbody>
</table>

### Positions 4, 5, 6, 7

Identify a unique, four-character name for the Form, Report, Process, or Table

#### SPAIDEN

- **S**: Student
- **A**: Application
- **P**: Person
- **I**: Identification

#### PPAIDEN

- **P**: HR/Payroll/Personnel
- **A**: Application
- **P**: Person
- **I**: Identification

#### FAABATC

- **F**: Finance
- **A**: Accounts Payable
- **B**: Application
- **A**: General Person
- **T**: Check Processing

#### SAAADMS

- **S**: Student
- **A**: Admissions
- **A**: Application
- **D**: Admissions Application

#### PPAGENL

- **P**: Hr/Payroll/Personnel
- **A**: Person
- **P**: Application

#### FGAENCB

- **F**: Finance
- **G**: General Ledger
- **A**: Application
- **E**: General Encumbrance
- **N**: Processing

#### ADMS

- **A**: Admissions Application

#### GENL

- **G**: General Information

#### ENCB

- **E**: Encumbrance

#### TSA2AME

- **T**: Accounts Receivable
- **S**: Student Accounts
- **A**: Receivable
- **M**: Adj Tuition Credit Manual
- **E**: Entry

#### DETL

- **D**: Course Detail Information
- **E**: Employee Search
- **T**: Adj Tuition Credit Manual
- **M**: Entry
Class Evaluation

Class: Banner INB Navigation and Exercises
Presenter(s): ____________________________

Please indicate your evaluation of each statement.

<table>
<thead>
<tr>
<th>Statement</th>
<th>Strongly Agree</th>
<th>Neutral</th>
<th>Strongly Disagree</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. The presentation was easy to follow.</td>
<td>4</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>2. The Presenter’s knowledge was sufficient for the topics.</td>
<td>4</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>3. The Presenter’s delivery helped me learn.</td>
<td>4</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>4. The class included opportunities for questions and discussion.</td>
<td>4</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>5. I know more than before I came to class.</td>
<td>4</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>6. Class materials will be helpful back on the job.</td>
<td>4</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>7. I will recommend this class to others.</td>
<td>4</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>8. I will recommend this presenter to others.</td>
<td>4</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>9. My evaluation of the overall class is:</td>
<td>4</td>
<td>1</td>
<td>2</td>
</tr>
</tbody>
</table>

The best part of this course:
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________

The least useful part of this course:
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________

Suggestions or other comments:
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________
_____________________________________________________________________

If you wish to be contacted, please complete the following:

Name: __________________________________________

Department: ____________________________________

Phone: _________________________________________

Email: _________________________________________

When completed, return the form before you leave the session, or mail to: AFISM | MS 5064